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Limbajul macro din OpenOffice.org

Un macro reprezintă o secvenţă de comenzi sau apăsări de taste înregistrată pentru o folosire 
ulterioară. Un exemplu de macro foarte simplu este cel care vă "tastează" adresa. Macro-urile 
pot reţine comenzi care implementează o multime de funcţii avansate, ca de exemplu cele 
condiţionale (de exemplu, dacă soldul este negativ, afişează-l cu roşu; dacă nu, cu negru), 
ciclare (dacă soldul este pozitiv, scade 10 din el) şi chiar interogarea utilizatorilor (de exemplu, 
se pot cere date de intrare). Unele din aceste comenzi sunt inspirate din limbajul de programare 
BASIC (BASIC este un acronim pentru Beginner’s All-purpose Symbolic Instruction Code). 
Este un lucru obişnuit să asociezi unui macro o apăsare de tastă sau apăsarea unui buton grafic 
astfel încât să poată fi executată o acţiune.

Limbajul macro din OpenOffice.org este foarte flexibil, permiţând automatizarea nu numai a 
soluţiilor simple, cât şi a celor complexe. Deşi poate fi instructiv să scrieţi macro-uri şi să 
învăţaţi despre modul în care lucrează OOo, aceasta s-ar putea să nu fie cea mai eficientă 
metodă de a vă folosi timpul. Macro este în mod special folositor când trebuie să afceţi acelaşi 
lucru de (foarte) multe ori, sau când doriţi să apăsaţi o singură tastă pentru a efectua o 
operaţiune care implică mai mulţi pasi. S-ar putea ca din când în când să doriţi să scrieţi 
macro-uri care să efectueze lucruri pe care altfel nu le puteti efectua în OOo prin sistemul de 
funcţii deja scrise şi meniurile oferite, dar înainte ar fi bine să cercetaţi cu atenţie dacă OOo nu 
vă oferă deja acea facilitate. De exemplui, adeseori se cere, pe lista de email a proiectului 
OOo, includerea unui macro care să înlăture din text, în Writer, paragrafele goale, vide. 
Această facilitate este însă deja oferită de funcţia AutoFormat (selectaţi Unelte > AutoCorrect 
> categoria Opţiuni, Tools > AutoCorrect > Options tab). Este posibil să folosiţi expresii 
regulate pentru a căuta şi înlocui spaţierile inutile. Aşadar, macro-urile au un scop, iar pentru 
alte aspecte ce exced acestui scop sunt soluţii dedicate. Acest capitol îşi propune să vă 
pregătească pentru situaţiile când va trebui să alegeţi macro-urile.

Notă OpenOffice.org este prescurtat OOo. “OpenOffice.org Basic” este în mod similar 
prescurtat “OOo Basic”. Pentru traducerea "macro", am preferat să păstrăm cuvântul, 
cel puţin la singular, şi în limba română, deoarece paronimul "macrou" (ro) folosit în 
alte traduceri nu are nici o legătura de sens cu "macro" (en). 

Limbajul macro OpenOffice.org este bazat pe limbajul de programare BASIC. OOo Basic 
interpretează şi execută căte o linie o dată. Aceste linii (de program) sunt organizate în rutine, 
numite şi proceduri, reunite pe baza scopului: împreună fac ceva anume. De exemplu, o rutină 
poate şterge antetul dintr-un fişier şi să introducă în loc antetul dumneavoastră. În OOo, 
rutinele care sunt grupate dpv. logic sunt stocate în module. De exemplu, într-un modul se pot 
stoca rutinele care găsesc şi corectează erorile comune din text. Modulele se grupeaza în 
biblioteci, iar bibliotecile sunt stocate în containerele de biblioteci. Containere de biblioteci pot 
fi chiar OOo, dar şi orice document OOo. Mai simplu zis, programele OOo şi oricare 
document OOo pot conţine biblioteci, module şi macro-uri.

Notă Un dialog este o fereastră ce apare pe ecran de obicei pentru a vă cere să introduceţi 
date sau să va informeze despre ceva. Dialogurile de obicei dispar după ce aţi 
introdus datele sau după ce aţi luat la cunoştinţă mesajul transmis. Dialogurile create 
de utilizator sunt stocate în bibliotecile de dialoguri similar cu bibliotecile de macro-
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uri. Fiecare bibliotecă poate conţine mai multe dialoguri. Containerele de biblioteci 
pot înmagazina atât biblioteci de macro-uri cât şi biblioteci de dialoguri. Citiţi 
capitolul 17, “Dialogs and Controls” în OpenOffice.org Macros Explained ca să 
aflaţi mai multe despre dialoguri.

Stocarea unui macro într-o bibliotec  dintr-ună  
document

Fiecare document OpenOffice.org este un container de biblioteci capabil să stocheze macro-uri 
şi dialoguri. Când un document conţine macro-urile folosite, posesia documentului înseamnă şi 
posesia macro-urilor respective. Aceasta este foarte convenabil pentru distribuţie  ca şi pentru 
stocare, deoarece o data ce aţi trimis destinatarului documentul acesta are disponibile şi macro-
urile.

Metoda tradiţională de a prezenta un limbaj de programare este de scrie un program care 
afişează mesajul “Hello World” (Salut Lume!). Există site-uri Web dedicate programelor care 
afişează "Hello World" în cât mai multe limbaje de programare (de exemplu, vedeţi 
http://www2.latech.edu/~acm/HelloWorld.shtml). În spiritul acestei tradiţii, primul nostru 
macro este o variaţie a “Hello World.”

Pasul 1. Crearea unei biblioteci
Toate documentele OOo, indiferent de tipul specific al documentului, pot sa conţină macro-uri. 
Pentru a adăuga un macro unui document OOo trebuie să deschideţi documentul pentru 
editare. Începeti prin a crea un document nou de tip text (dacă nu este deschis nici un alt 
document, probabil va fi denumit “Untitled1”). Când se crează documentul, OOo crează în el o 
bibliotecă vidă numită Standard. Biblioteca Standard va rămâne vidă până când veţi crea 
(manual) un nou modul. Folosiţi dialogul Macro pentru a administra modulelele şi bibliotecile: 
selectaţi Unelte > Macro-uri > Administrare macro-uri > OpenOffice.org Basic (Tools > 
Macros > Organize Macros > OpenOffice.org Basic) (vedeţi Imaginea 1).

Lista “Macro from” arată containerele de biblioteci disponibile; aceastea includ toate 
documentele deschise şi macro-urile distribuite cu OOo. Macro-urile dumneavoastră personale, 
denumite “My Macros” în Imaginea 1, sunt de obicei stocate în directorul dumneavoastră 
personal. Macro-urile incluse în OOo (“OpenOffice.org Macros”) sunt de obicei stocate în 
directoare separate în cadrul instalării OOo. Deşi macro-urile dumneavoastră personale sunt 
stocate şi afişate separat de cele incluse în OOo, ambele sunt considerate ca parte a 
bibliotecilor aplicaţiei OOo. Containerele de biblioteci din document sunt afişate 
(individualizate) folosind numele documentului. Majoritatea containerelor au deja inclusă o 
biblioteca numită Standard. Daţi dublu clic pe pictograma unei biblioteci dintr-un container 
pentru a afişa (sau a ascunde) bibliotecile conţinute. Similar, daţi dublu clic pe o bibliotecă 
pentru a afişa sau a ascunde modulele conţinute.

Notă Înainte de versiunea 2.0, OOo afişa “My Macros” şi “OpenOffice.org Macros” în 
aceeaşi listă. Noile dialoguri sunt mai intuitive dar au aspect şi funcţionalitate 
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similare. A fost adăugat suport pentru a edita şi rula programe scrise în alte limbaje 
decât OOo Basic; de exemplu vedeţi Unelte > Macro-uri > Administrare macrou-
uri > JavaScript (Tools > Macros > Organize Macros > JavaScript).

Imaginea 1. Folosiţi dialogul Macro pentru a crea noi macro-uri şi pentru a administra 
bibliotecile.

Biblioteca Standard din documentele nou create a fost creată, la rândul ei, în mod automat o 
dată cu documentul. Dar documentul nu conţine după creare nici un modul, iar macrou-urile 
sunt stocate în module. Deşi puteţi da clic pe butonul Nou (New) pentru a crea un modul, nu o 
faceţi; scopul acestei secţiuni este de a crea o nouă bibliotecă.

PONT Nu stocaţi macro-urile dumneavoastră în biblioteca Standard. Creaţi o bibliotecă nouă 
cu o denumire sugestivă special pentru ele, deoarece când este adăugată o bibliotecă 
aceasta va suprascrie biblioteca cu acelaşi nume existentă în document. Dacă vă veţi 
denumi toate bibliotecile Standard nu veţi mai putea să adăugaţi biblioteci dintr-un 
document în altul.

Daţi clic pe butonul Administrare (Organizer) pentru a deschide dialogul Administrare 
macro-uri (Macro Organizer) (vedeţi Imaginea 2). În dialogul Macro sunt listate toate 
containerele de biblioteci. În imaginea 2, biblioteca Standard este marcată în documentul 
“Untitled1”; derulaţi lista dacă este necesar pentru a găsi “Untitled1”. Dialogul Administrare 
macro-uri este unul cu categorii, iar categoria selectată este Module (Modules). După cum vă 
sugerează şi numele, categoria Module(s) se referă la module. În dialog sunt mai multe 
elemente, după cum urmează:

• Butonul Nou modul (New Module) creează un nou modul în biblioteca selectată.

• Butonul Şterge (Delete) şterge modulul selectat; este disponibil doar dacă este selectat 
un modul.
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• Butonul Edit(are) deschide modulul selectat pentru editare în IDE; este disponibil doar 
dacă este selectat un modul.

• Butonul Închide (Close) închide dialogul Administrare macro-uri.

Imaginea 2. Folosiţi dialogul Administrare macro-uri pentru administrarea acestora.

Scopul acestei secţiuni este de a crea o bibliotecă cu un nume sugestiv care să fie stocată în 
documentul “Untitled1”. Daţi clic pe categoria Biblioteci (Libraries) pentru a vedea opţiunile 
privitoare la acestea (vedeţi imaginea 3). 

Imaginea 3. Folosiţi dialogul Administrare macro-uri pentru a administra 
bibliotecile.

Când este afişată această categorie sunt selectate ca locaţie containerele incluse în aplicaţie(My 
Macros & Dialogs). Selectaţi documentul “Untitled1” pentru ca modificările să le efectuaţi 
asupra documentului în lucru, Untitled1. Butoanele afişate în cadrul categoriei Biblioteci 
afectează bibliotecile, nu modulele. Iată descrierea lor:

• Butonul Nou (New) crează o nouă bibliotecă în document selectat sau în aplicaţie.
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• Butonul  Parolă (Password) vă permite să stabiliţi o parolă (sau să o modificaţi) pentru 
accesul la biblioteca selectată. Nu puteţi parola biblioteca standard.

• Butonul Şterge (Delete) şterge biblioteca selectatată; este disponibil doar dacă este 
selectată o bibliotecă.

• Butonul Adaugă (Append) vă oferă un mecanism de a copia o bibliotecă dintr-un alt 
container de biblioteci (document sau aplicaţie) în containerul de biblioteci selectat în 
lista Aplicaţie/ Document (Application/ Document). Administrarea bibliotecilor este 
discutată mai jos în acest capitol.

• Butonul Edit(are) deschide biblioteca selectată pentru editare în IDE..

• Butonul Închide (Close) închide dialogul Administrare macro-uri.

Daţi clic pe butonul Nou (New) pentru a crea o bibliotecă nouă (vedeţi imaginea 4). Deşi 
numele implicit este “Library1”, este mai bine să alegeti dumneavoastră un nume sugestiv (de 
exemplu, “PrimaMeaBibliotecă” sau “BibliotecăTest”. Apăsaţi OK pentru a o crea.

Imaginea 4. Alegeţi un nume sugestiv pentru bibliotecă.

Administrare macro-uri va conţine acum biblioteca nou-creată în lista bibliotecilor (vedeţi 
Imaginea 5).

Imaginea 5. Documentul conţine acum biblioteca intitulată TestLibrary.

Pasul 2. Crearea unui modul
Macro-urile sunt stocate în module, astfel încqt următorul pas este să creem un modul în nou 
creata bibliotecă. Presupunând că administrare macro-uri (vedeţi Imaginea 3) este încă deschis, 
selectaţi categoria Module(s) (vedeţi Imaginea 6). 
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Imaginea 6. Biblioteca TestLibrary conţine un modul denumit Module1.

Nou creata bibliotecă TestLibrary este acum afişată în Administrare macro-uri. Selectaţi 
TestLibrary sau orice alt modul conţinut în acea bibliotecă şi apoi apăsaţi butonul Nou modul 
(New Module) pentru a crea un nou modul (vedeţi Imaginea 7). Numele implicit este 
Module1; alegeţi un nume mai sugestiv pentru modul şi apăsaţi OK pentru a-l crea.

Imaginea 7. Alegeţi un nume sugestiv pentru modul.

PONT Folosiţi nume de module sugestive pentru a preveni confuziile. Aceasta este important 
când aveţi mai multe module.

O greşeală des întâlnită este să selectaţi un alt container de biblioteci fie în dialogul macro fie 
în Administrare macro-uri. Cea mai des întâlnită greşeală este să selectaţi o bibliotecă dintr-un 
container din aplicaţie (My Macros & Dialogs) în loc de cea dintr-un anumit document. Găsiţi 
numele documentului în listă. Numele documentului este determinat de titlul specificat în 
caracteristicile documentului (Properties). Folosiţi Fişier > Caracteristici (File > Properties) 
pentru a deschide dialogul Caracteristici. Titlul este specificat în categoria Descriere 
(Description). Dacă nu este specificat nici un titlu va fi folosit numele fişierului.

Notă Două documente cu acelaşi titlu vor apare cu acelaşi nume în dialogul Macro, 
dialogul Administrare macro-uri şi vor avea acelaşi titlu de fereastră. Aceasta va crea 
confuzii, astfel încât încercaţi să o evitaţi.
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Pasul 3. Introducerea primului macro propriu
Dacă dialogul Administrare macro-uri (Macro Organizer) este încă deschis, puteţi selecta 
modulul nou creat şi să apăsaţi butonul Edit(are). Aceasta va porni Basic IDE (adică interfaţa 
de programare în Basic). 

O altă opţiune este să folosiţi dialogul Macro. Dacă dialogul Administrare macro-uri (Macro 
Organizer) este încă deschis, apăsaţi butonul Închide (Close) pentru a deschide dialogul 
Macro. Dacă Administrare macro-uri nu este deschis, selectaţi Unelte > Macro-uri > 
Administrare macro-uri > OpenOffice.org Basic (Tools > Macros > Organize Macros > 
OpenOffice.org Basic) pentru a deschide dialogul Macro (vedeţi Imaginea 8).

Imaginea 8. Selectaţi un anumit macro.

Iată şi o descriere a butoanelor din dialogul Macro:

• Butonul Execută (Run) execută macro-ul selectat. Macroul este selectat în lista din 
dreapta, numele său apare şi în câmpul din stânga-sus denumit "Nume macro" (“Macro 
name”).

• Butonul Închide (Close) închide dialogul Macro.

• Butonul Asociază (Assign) asociază un macro unui anumit eveniment. Această asociere 
este discutată mai târziu.

• Butonul Edit(are) deschide mediul integrat de editare (IDE) şi editează macro-ul 
selectat.

• Butonul Şterge (Delete) şterge macro-ul specificat. Acest buton este disponibil numai 
dacă este selectat un macro. Dacă în lista "Macro din" (“Macro from”) selectaţi o 
bibliotecă sau un document, butonul Şterge (Delete) se schimbă în Nou (New). Butonul 
Nou (New) crează un nou macro în biblioteca selectată.

• Butonul Administrare (Organizer) deschide dialogul Administrare macro-uri (Macro 
Organizer).
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• Butonul Ajutor (Help) deschide programul de ajutorare.

Scopul dialogului Macro este să editaţi macro-uri individuale. Selectaţi MyFirstModule şi 
apăsaţi butonul Edit(are) pentru a deschide Basic IDE (vedeţi Imaginea 9). O subrutină fără 
instrucţiuni, numită Main, este creată în mod automat o dată cu modulul. IDE-ul arătat în 
Imaginea 9 a fost deschis dând clic pe MyFirstModule şi apoi pe butonul Edit(are). Vă rog să 
introduceţi codul arătat în Listarea 1.

Imaginea 9. Dezvoltarea macro-urilor în IDE.

Listarea 1. Programul “Hello World” se află în fişierul SC01.sxw.
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Sub main

  HelloWorld2()

End Sub

Sub HelloWorld1

  Print "Hello World One"

End Sub

Sub HelloWorld2

  Print "Hello World Two"

End Sub

IDE-ul conţine un panou cu unelte pentru Macro şi un panou cu funcţii specifice, arătate în 
Imaginea 9. (Majoritatea pictogramelor de pe panoul Macro sunt identificate în Imaginea 13). 
Ţineţi cursorul mausului deasupra unei pictograme pentru 2 secunde pentru a citi textul scurt 
de ajutor care apare; este o indicaţie despre menirea pictogramei.

Apăsaţi pictograma Compilează (Compile) pentru a verifica eventualele greşeli din textul 
macro-ului. Nu este afişat nici un mesaj dacă totul este în regulă, fiind semnalate doar 
eventualele erori (vedeţi Imaginea 10). Pictograma Compile compilează numai modulul curent.

Imaginea 10. Apăsaţi pictograma Compile(ază) pentru a găsi greşelile de sintaxă ca 
de exemplu lipsa ghilimelelor.

Modificaţi codul din Listarea 1 pentru a simula o eroare. Înlăturaţi ghilimelele de la comanda 
Print din HelloWorld1 (vedeţi Imaginea 10). Apoi apăsaţi pictograma Compile(ază). Un dialog 
va afişa mesajul erorii pentru prima greşeală găsită. Mesajul de eroare din Imaginea 10 indică 
faptul că trebuia să existe o ghilimea care nu a fost găsită. Prima ghilimea este marcată, iar o 
săgeată roşie indică linia în care a apărut eroarea. Apăsaţi butonul OK pentru a închide dialogul 
de eroare, corectaţi adăugând ghilimeaua la sfârşitul rândului, şi apoi recompilaţi codul.
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Apăsaţi pictograma Execută (Run) pentru a executa prima rutină din modulul curent. Nu este 
necesar să apăsaţi mai întâi pe pictograma Compile(ază), deoarece comanda Execută (Run) 
compilează în mod automat toate modulele din biblioteca curentă. Apăsând pe Execută (Run) 
veţi rula numai prima rutină din modul. Pentru codul din Listarea 1, comanda Execută (Run) 
va rula numai prima subrutină, cea numită “main”. Aceasta va apela subrutina HelloWorld2, 
afişând dialogul arătat în Imaginea 11. Apăsaţi OK pentru a închide dialogul sau daţi Anulare 
(Cancel) pentru a opri executarea macro-ului.

Imaginea 11. Apăsaţi OK pentru a închide dialogul.

Pictograma Execută (Run) execută întotdeauna primul macro din modulul curent. În 
consecinţă, nu veti putea rula astfel HelloWorld1. Pentru a rula HelloWorld1, puteţi folosi una 
dintre aceste metode:

• Poziţionaţi HelloWorld1 ca prima rutină din modul şi apoi apăsaţi pictograma Execută 
(Run).

• Modificaţi subrutina Main pentru a apela HelloWorld1 în loc de HelloWorld2.

• Folosiţi dialogul Macro (arătat în Imaginea 8) pentru a executa oricare dintre subrutinele 
din modul.

• Adăugaţi în documentul OpenOffice.org un buton care să apeleze HelloWorld1. Această 
metodă este explicată mai jos.

• Asociaţi un macro unei apăsari de tastă. Ca să faceţi aceasta, alegeţi Unelte > 
Configurare (Tools > Configure) pentru a deschide dialogul de Configurare şi apoi 
selectaţi categoria Tastatură (Keyboard). Bibliotecile Macro sunt la finalul listei 
Category. Acelaşi lucru îl puteti face şi apăsând Unelte > Macro-uri > Administrare 
macro-uri >OpenOffice.org Basic (Tools > Macros > Organize Macros > 
OpenOffice.org Basic), selectând macro-ul dorit, şi apoi apăsând butonul Asociază 
(Assign) pentru a deschid fereastra Configurare (Configuration). Categoriile diverse din 
acest dialog vă permit să asociaţi macro-ul pentru a fi executat ca opţiune din sistemul 
de meniuri, ca rezultat al apăsarii unei taste, o pictogramă dintr-un panou sau la un 
eveniment generat de calculator.

• Adăugaţi o pictogramă panoului cu unelte care va apela HelloWorld1.

Pentru a folosi dialogul Macro pentru a executa oricare dintre subrutinele dintr-un modul 
urmaţi aceşti paşi:

1) Selectaţi Unelte > Macro-uri > Administrare Macro-uri > OpenOffice.org Basic 
(Tools > Macros > Organize Macros > OpenOffice.org Basic) pentru a deschide 
dialogul Macro (vedeţi Imaginea 8).

2) Găsiţi documentul care conţine modulul în lista "Macro din" (“Macro from”).

3) Daţi dublu clic pe o bibliotecă pentru a comuta afişarea modulelor conţinute.
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CIORN  – bazat  pe software nefinalizatĂ ă Stocarea unui macro într-o
bibliotec  dintr-un documentă

4) Selectaţi modulul pentru a afişa subrutinele şi funcţiile conţinute în lista "Macro-urile 
existente în: <numele modulului selectat>"(“Existing macros in: <selected module 
name>”).

5) Selectaţi subrutina dorită sau funcţia de executat—de exemplu, HelloWorld1.

6) Apăsaţi butonul Execută (Run) pentru a executa subrutina sau funcţia.

PONT Când dezvoltaţi o subrutină, plasaţi-o prima în modul astfel încât să o puteţi executa 
rapid apăsând butonul Execută (Run). O altă soluţie este să o apelaţi din prima 
subrutină, aşa cum se face în Listarea 1. Aceste soluţii sunt mai rapide decât daca 
folosiţi dialogul Macro.

Codul folosit în acest capitol este disponibil într-un document text OpenOffice.org numit 
SC01.sxw. Descărcaţi-l şi deschideţi-l. Când un document ce conţine macro-uri este deschis 
OpenOffice.org va afişa un avertisment (vedeţi Imaginea 12). Acest avertisment este menit a 
preveni să executaţi accidental un macro ce conţine viruşi. Deşi puteţi executa manual orice 
macro folosind dialogul Macro, butoanele din document care au asociate macro-uri nu vor 
funcţiona. Apăsaţi Execută (Run) pentru a activa butoanele respective din SC01.sxw.

PONT Puteţi configura un document pentru a executa în mod automat un macro la încarcarea 
sa. Aceasta este şi metoda folosită de viruşi pentru a se răspândi. Dacă documentul nu 
ar trebui să conţină macro-uri alegeţi întotdeauna Nu executa (Do Not Run). Aceasta 
va preveni toate macro-urile de a fi executate automat la încărcarea documentului.

Imaginea 12. Tocmai aţi deschis un document OpenOffice.org care conţine un macro.

SC01.sxw conţine trei butoane: Main, Hello World 1 şi Hello World 2. Fiecare buton este 
configurat pentru a executa rutina corespunzătoare numelui când este apăsat. Butoanele nu vor 
face însă nimic dacă apăsaţi Nu executa (Do Not Run) când încărcaţi documentul.
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CIORN  – bazat  pe software nefinalizatĂ ă Stocarea unui macro într-o
bibliotec  dintr-un documentă

Este posibil să adăugati un director la lista "locaţii sigure" (“secure paths”). Dacă sunteţi sigur 
că un director conţine documente ce nu sunt virusate atunci adăugaţi-l la această listă. Folosiţi 
Unelte > Opţiuni > OpenOffice.org > Securitate > Securitate macro-uri > Surse sigure 
(Tools > Options > OpenOffice.org > Security > Macro Security > Trusted Sources) şi 
adăugaţi directoarele. Toate documentele încărcate dintr-o locaţie "sigură" vor fi considerate 
sigure iar macro-urile vor fi rulate întotdeauna.

Stocarea unui macro într-o bibliotec  dintr-oă  
aplica ieţ

Chiar aplicaţia OpenOffice.org este un container de biblioteci. Este aşadar un loc excelent de a 
stoca cod şi dialogul folosite în mod comun în documente. Controlul versiunilor este uşurat 
dacă macro-urile sunt stocate într-un singur loc. Dacă acelaşi macro este conţinut în 5 
documente, nu numai că va ocupa loc de stocare suplimentar, dar dacă doriţi să îl modificati va 
trebui să o faceţi în toate cele 5 documente.

Pentru a stoca un macro în bibliotecile dintr-o aplicaţie folosiţi aceleaşi metode ca pentru 
documente. Containerul din aplicaţie foloseşte două denumiri, “My Macros” (Macro-urile 
mele) şi “OpenOffice.org Macros” (Macro-urile OOo). Aplicaţia OOo include mai multe 
biblioteci stocate ca “OpenOffice.org Macros”. Folosiţi dialogul Administrare macro-uri 
(Macro Organizer) din Imaginea 3 pentru a adăuga biblioteci noi.

Aten ieţ Dezinstalarea OpenOffice.org poate să antreneze ştergerea bibliotecilor stocate la 
nivelul aplicaţiei, astfel încât ar trebui întotdeauna să păstraţi o copie de siguranţă a 
acestora.  Reinstalarea sau actualizarea cu o versiune nouă a OpenOffice.org poate de 
asemenea suprascrie bibliotecile aplicaţiei. Salvaţi aceste biblioteci o dată cu 
documentele. 

Adesea, bibliotecile vor exista, dar conţinutul lor va fi pierdut deoarece calea către 
biblioteci va fi modificată o dată cu (re)instalarea, însă în acest caz este posibil să 
recuperaţi conţinutul acestora indicând calea către biblioteci aşa cum era înainte. 
Pentru mai multe informaţii, vedeţi secţiunea "Administrarea bibliotecilor" mai jos în 
acest capitol.

Fiecare bibliotecă de aplicaţie este stocată în propriul său director. Pentru a afla unde salvează 
OpenOffice.org aceste biblioteci selectaţi Unelte > Opţiuni (Tools > Options). În dialogul 
Opţiuni (Options), expandaţi ramura OpenOffice.org în meniul arborescent şi selectaţi Căi 
(Paths). Intrarea Basic vă arată localizarea bibliotecilor externe.

Ini iere în limbajul macroţ 12



CIORN  – bazat  pe software nefinalizatĂ ă Stocarea unui macro într-o
bibliotec  dintr-o aplica ieă ţ

Faceţi o copie a bibliotecilor conţinute la nivelul aplicaţiei OOo înainte de a instala o noua 
versiune. Dacă veţi instala OOo în acelaşi loc, atunci va suprascrie fişierele de configurare şi 
nu va mai corespunde calea către aceste biblioteci. De obicei, bibliotecile nu sunt afectate, dar 
OOo nu va mai şti unde să le caute. Pentru a refolosi aceste biblioteci, indiferent unde se află, 
folosiţi categoria Biblioteci (Libraries) din dialogul Administrare macro-uri (Macro Organizer) 
(vedeţi Imaginea 3). Verificaţi că “My Macros” este selectat în lista Aplicaţii/Documente 
(Application/Document) şi apoi apăsaţi butonul Adaugă (Append). Alegeţi directorul care 
conţine bibliotecile dorite. Selectaţi fişierul script.xlb şi apăsaţi Deschide (Open). Faceţi 
aceasta pentru fiecare bibliotecă pe care doriţi să o restabiliţi. Această metodă poate fi folosită 
şi pentru a adăuga bibliotecile stocate în documente.

PONT Nu folosiţi biblioteca Standard dacă este posibil să doriţi la un moment dat să 
adăugaţi biblioteca în alta parte. În schimb, stocaţi-vă modulele în biblioteci proprii, 
separate, cu nume sugestive. Biblioteca Standard este una specială şi nu o puteţi 
şterge sau suprascrie.

Pentru a exersa adăugarea unui macro în biblioteca de la nivelul aplicaţiei OOo, deschideti 
dialogul Administrare macro-uri. Verificaţi containerul curent să fie “My Macros”. Apăsaţi 
butonul Modul nou (New Module) pentru a adăuga noi module în bibliotecile de la nivelul 
aplicaţiei OOo. Pentru a adăuga noi biblioteci selectaţi categoria Biblioteci (Libraries). 
Verificaţi că “My Macros” este selectat în lista Aplicaţii/Documente (Application/Document),şi 
apoi apăsaţi butonul Nou (New).

Bibliotecile stocate în documente pot fi adăugate în containerul de biblioteci de la nivelul 
aplicaţiei. Când adăugaţi o bibliotecă se va suprascrie biblioteca cu acelaşi nume deja 
existentă, astfel încât este recomandat să vă creaţi propriile biblioteci cu deumiri sugestive 
pentru a păstra propriile macro-uri. Aceasta va preveni probleme apărute la mutarea macro-
urilor dintr-un container în altul.

Mediul de dezvoltare integrat (IDE)

Mediul de dezvoltare integrat (IDE) este de fapt un set de unelte de programare menite să 
faciliteze crearea şi scrierea de software. OpenOffice.org include un IDE performant, uneltele 
disponibile rulând, editând şi detectând erorile din codul scris de dumneavoastră (macro-uri), 
aşa ca merită să petreceţi un timp pentru a deveni familar cu acesta. Imaginea 13 arată IDE-ul 
cu numeroase comentarii despre pictograme şi zonele ferestrei. Zona centrală unde apare codul 
macro-ului în lucru este fereastra editorului. Multe dintre facilitaţi, cum sunt Stop,  Punct de 
control (Breakpoint), Pas cu pas (Single Step) şi Panoul supraveghere (Watch pane) servesc ca 
un depanator ( debugger, n.t. unealta pentru identificat erorile) simplu si eficient pentru codul 
macro.

Această secţiune vă oferă o privire de ansamblu a funcţiilor standard ale IDE-ului. Nu fiţi 
contrariaţi de faptul că nu veţi reuşi să înţelegeti totul din prima. Vă veţi familiariza cu acestea 
pe măsură ce veţi lucra exemplele. Primul set de funcţii sunt folosite la depanarea codului iar 
cele descrise la finalul acestei secţiuni se referă la administrarea obiectelor în macro-uri, 
biblioteci şi documente. Acum însă voi descrie funcţiile asociate butoanelor grafice.
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CIORN  – bazat  pe software nefinalizatĂ ă Mediul de dezvoltare integrat
(IDE)

Butonul Compile(ază) compilează si verifică sintaxa codului numai din modulul curent. 
Butonul Compile(ază) este util dacă nu doriţi să rulaţi macro-ul însă vreţi să vedeţi ca nu sunt 
erori de sintaxă. Sunt afişate mesaje doar în cazul în care sunt găsite erori (vedeţi Imaginea 
10). Când este găsită o eroare apare un dialog care o indică. O săgeată în coloana Punct de 
control (Breakpoint) va marca linia unde a apărut eroarea iar porţiunea din cod care a cauzat 
eroarea este colorată. Apăsaţi butonul OK pentru a închide dialogul ce semnalează eroarea.

Notă Compilare înseamnă traducerea codului din limbajul macro din OOo în cod 
executabil direct de calculator.

Butonul Execută (Run) compilează toate modulele din biblioteca curentă şi apoi execută 
prima subrutină sau funcţie din modulul curent. Diferă faţă de butonul Compile(ază), care 
compilează numai modulul curent.

Imaginea 13. OpenOffice.org include un IDE performant.

Butonul Stop Macro serveşte la oprirea rulării unui macro. Când îl apăsaţi macro-ul este oprit 
definitiv, nu veţi putea relua excutarea lui din punctul în care rămăsese. Acest duton este 
disponibil numai când se execută un macro şi arată ca un semn "Stop" de circulaţie auto.
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CIORN  – bazat  pe software nefinalizatĂ ă Mediul de dezvoltare integrat
(IDE)

Butonul Procedură la pas (Procedure Step) execută numai instrucţiunea curentă din 
procedura (rutina) curentă. Dacă nici un macro nu se execută, atunci prima rutină din primul 
modul este pornită iar prima sa instrucţiune va constitui instrucţiunea curentă. Instrucţiunea 
curentă este indicată de o săgeată în coloana Punct de control (Breakpoint) iar cursorul este 
mutat la acea linie. Dacă însă un macro se executa deja, atunci este executată instrucţiunea 
curentă iar următoarea instrucţiune este marcată ca şi curentă. Butonul Procedura la pas 
(Procedure Step) priveşte apelurile către alte subrutine ca o singura instrucţiune şi nu le excută 
tot la pas, ci dintr-o dată. Observaţi că pictograma reprezintă o săgeată care sare peste acolade, 
acoladele reprezentând o subrutină sau un apel de funcţie.

Butonul Pas cu pas (Single Step) execută instrucţiunea curentă. Se comportă la fel ca 
Procedură la pas (Procedure Step) cu excepţia că subrutinele şi funcţiile nu sunt tratate ca o 
singură instrucţiune, ci se va urmări executarea lor în mod similar. Observati deasemenea 
simbolul pictogramei, şi anume săgeata care intră în interiorul acoladelor.

Butonul Pas înapoi (Step Back) execută toate instrucţiunile până la sfârşitul subrutinei curente 
şi apoi iese din aceasta. Cu alte cuvinte nu mai trebuie să apăsaţi Procedură la pas (Procedure 
Step) până când ajungeţi la ultima instrucţiune din subrutină (End Sub sau End Function) şi 
apoi încă o dată, pentru a ieşi din subrutină. Dacă din greşeală apăsaţi Pas cu pas (Single step) 
în loc de Procedură la pas (Procedure Step) puteţi să apăsaţi o singură dată Pas înapoi (Step 
Back). Observaţi desenul pictogramei, şi anume o săgeată care iese dintre acolade.

Butonul Comută punct de control (Breakpoint On/Off) fixează un punct de control la 
instrucţiunea unde se află cursorul, iar în coloana Punct de comtrol (Breakpoint) va fi afişat un 
semn roşu de stop. Daţi dublu clic în coloana Punct de comtrol (Breakpoint) pentru a comuta 
punctul de control de la acea instrucţiune. Daţi clic dreapta în coloana Breakpoint pentru a-l 
activa sau dezactiva.

Butonul Administrare puncte de control (Manage Breakpoints) afişează dialogul 
Administrare puncte de control (Manage Breakpoints) (vedeţi Imaginea 14).

Imaginea 14. Editaţi şi configuraţi punctele de control manual.

Butonul Supraveghează (Enable Watch) consideră cuvântul curent (cel în care se află 
cursorul) ca fiind o variabilă şi îl adaugă în Panoul supraveghere (Watch pane).
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(IDE)

Butonul Catalogul de obiecte (Object Catalog) deschide fereastra Obiecte (Objects) (vedeţi 
Imaginea 15), unde puteţi inspecta toate containerele de biblioteci disponibile, aflând ce 
biblioteci, subrutine şi module sunt disponibile. Daţi dublu clic pe o subrutină pentru a o 
încărca în IDE. Această funcţionalitate este similară cu a Navigatorului din documentele OOo 
Writer. Pentru ca modulele dintr-un fişier să apară în Catalogul de obiecte acesta (fişierul) 
trebuie mai întâi salvat.

PONT Lasaţi deschisă fereastra Obiecte şi folosiţi-o ca un navigator pentru a regăsi rapid 
modulele, bibliotecile sau subrutinele, chiar şi în cadrul aceluiaşi modul.

Imaginea 15. Puteţi inspecta bibliotecile şi modulele disponibile în fereastra Obiecte.

Butonul Select(are) Macro încarcă dialogul Macro. Selectarea Unelte > Macro-uri > 
Administrare macro-uri > OpenOffice.org Basic (Tools > Macros > Organize Macros > 
OpenOffice.org Basic) încarcă deasemenea dialogul Macro.

Butonul Select(are) Module încarcă dialogul Administrare macro (Macro Organizer). Acest 
buton grafic are acelaşi efect cu a apăsa butonul Administrare (Organizer) în dialogul Macro 
(vedeţi Imaginea 2 şi Imaginea 3).

Selectaţi sau poziţionaţi cursorul la stânga unei paranteze şi apoi apăsaţi butonul Găseşte 
parantezele (Find Parentheses) pentru a identifica perechile de paranteze. Când IDE-ul va 
găsi paranteza corespondentă va selecta parantezele şi tot ce cuprind ele.

Pentru a deschide fereastra Controale (Controls) apăsaţi butonul Controale (Controls) în timp 
ce editati un dialog. (Pentru mai multe informaţii despre controale citiţi capitolul 17, “Dialogs 
and Controls”, al cărţii OpenOffice.org Macros Explained)

Pentru a crea un dialog pentru editare, apăsaţi butonul Încarcă modul (Load Module) pentru 
a deschide dialogul Administrare macro-uri (Macro Organizer). Selectaţi categoria Dialog şi 
apăsaţi butonul Dialog nou (New Dialog) pentru a crea un nou dialog. Vedeţi capitolul 17, 
“Dialogs and Controls” din OpenOffice.org Macros Explained pentru mai multe informaţii 
despre crearea şi utilizarea dialogurilor în macro-uri.
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Ultimele doua butoane, Inserează cod sursă Basic (Insert Basic Source) şi Salvează Basic 
(Save Basic), sunt folosite pentru a insera în modulul curent text stocat într-un fişier extern şi 
respectiv pentru a salva textul programului din modulul curent într-un fisier extern. Aceasta 
este o metodă excelentă pentru a face o copie de siguranţă sau pentru a trimite cu usurinţă unei 
alte persoane codul scris de dumneavoastră. Acţiunile sunt diferite de cele efectuate de butonul 
grafic Disk, care este folosit pentru a salva întreaga bibliotecă sau tot documentul care conţine 
modulul.

Folosirea Punctelor de control (breakpoints)
Puteţi opri rularea unui macro la un punct anume din codul sau sursă stabilind acolo un punct 
de control. Veţi putea astfel să inspectaţi variabilele, să reluaţi executarea macro-ului sau să 
executaţi macro-ul în continuare în modul pas cu pas. Dacă macro-ul nu funcţionează si vreţi 
să vedeţi de ce atunci îl puteţi executa pas cu pas (se execută câte o instrucţiune o dată) şi 
astfel să-l supravegheaţi în timp ce rulează, realizând cauza erorii. Însă daca sunt executate 
foarte multe instrucţiuni înainte de se executa codul problematic este mult mai fezabil să 
stabiliţi un punct de control la începutul secvenţei de cod care nu funcţionează corespunzător. 
Programul se va opri din execuţie şi puteţi executa pas cu pas şi supraveghea algoritmul.

Butonul Comută punct de control (Breakpoint On/Off) stabileşte un punct de control la 
instrucţiunea unde se află cursorul. Un semn roşu de stop în coloana Punct de control 
(Breakpoint) marchează linia respectivă. Pentru a stabili un punct de control puteţi şi să daţi  un 
dublu clic în aceasta coloană, iar pentru a comuta starea de activat / dezactivat a punctului de 
control este suficient să îi daţi clic dreapta. 

Butonul Administrare puncte de control (Manage Breakpoints) încarcă dialogul 
Administrare puncte de control (Manage Breakpoints) (vedeţi Imaginea 14). Toate punctele de 
control active vor apare în lista din partea de jos a dialogului. Pentru a adăuga un punct 
introduceţi numărul liniei în cqmpul din partea de sus a dialogului şi apoi apăsaţi butonul Nou 
(New). Pentru a sterge un punct selectaţi punctul în listă şi apoi apăsaţi butonul Şterge 
(Delete). Debifaţi căsuţa Activ(e) pentru a dezactiva punctul corespunzător fără a-l şterge. 
Parametrul Contor de trecere (Pass Count) indică numărul de treceri prin punctul respectiv 
pentru ca să fie activat. Dacă de exemplu acesta este patru (4), atunci a patra oară când se 
ajunge la instrucţiunea respectivă execuţia este oprită. Aceasta este util atunci când eroarea 
apare de abia după mai multe rulări.

Sunt două situaţii în care un punct de control (breakpoint) va fi ignorat: fie contorul de treceri 
este nenul, fie punctul este setat ca inactiv în dialogul Administrare puncte de control (Manage 
Breakpoints). Fiecare punct are asociat un contor care este decrementat atunci când se ajunge la 
instrucţiune (şi înainte de a o executa). Când rezultatul decrementării este zero punctul va 
deveni activ şi va rămâne astfel. Ţineţi minte că acest contor nu va fi reiniţializat cu valoarea 
originală când macro-ul este terminat sau restartat.
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(IDE)

Este simplu de monitorizat valorile luate de variabilele din program pe parcursul executării 
unei rutine. Poziţionaţi cursorul lângă sau între caracterele oricărui cuvânt din fereastra 
Edit(are) şi apăsaţi butonul Supraveghează (Enable Watch) pentru a adăuga cuvântul respectiv 
în Panoul supraveghere (Watch pane). Panoul afişează valorile luate de variabilele aşa-numite 
vizibile, adică cele care pot fi accesate de instrucţiunea curentă. Textul "ne-vizibil" (“<Out of 
Scope>”) este afişat pentru variabilele care există, dar nu pot fi accesate. Altă metodă de a 
adăuga variabile în Panoul de supraveghere este de a tasta numele variabilei în fereastra 
Supraveghere şi de a apăsa Enter. Pentru a şterge numele din Panou, selectaţi-l în Panou sau 
tastaţi-i numele în fereastra Supraveghere şi apoi apăsaţi butonul Ignoră (Remove Watch). 
Daţi clic pe un nume în Panou pentru a-l afişa în fereastra Supraveghere. În OOo 2.0 au fost 
adăugate noi facilităţi fereastrei Supraveghere, ca de exemplu să urmăriţi variabile matriciale 
sau obiecte; poate fi impresionant.

Notă O variabilă care este accesibilă se numeşte şi vizibilă. De exemplu, dacă variabila "j" 
este definită în rutina HelloWorld1 nu va fi vizibilă şi în HelloWorld2. Aceasta va fi 
discutat mai târziu.

Administrarea bibliotecilor

Această secţiune tratează crearea, transferul şi redenumirea modulelor şi a bibliotecilor. Pentru 
a înţelege administrarea bibliotecilor este necesar să vă reamintiţi câteva noţiuni de bază:

• Un container de biblioteci conţine zero sau mai multe biblioteci.

• Fiecare bibliotecă conţine zero sau mai multe module şi dialoguri.

• Fiecare modul conţine zero sau mai multe macro-uri.

• Aplicaţia este un container de biblioteci denumit “My Macros” şi “OpenOffice.org 
Macros”. Bibliotecile stocate în aplicaţie sunt disponibile pentru toate macro-urile.

• Fiecare document este un container de biblioteci.

• Biblioteca denumită Standard este specială; există întotdeauna şi nu poate fi suprascrisă. 
Vă recomand să nu folosiţi biblioteca Standard.

• Denumiţi în mod sugestiv bibliotecile şi modulele pe care le creaţi. De exemplu, 
Biblioteca1 şi Modulul4 nu sunt sugestive, pe când AXONFacturăFormular1 este ceva 
mai descriptiv.

Cum sunt stocate bibliotecile
Bibliotecile OpenOffice.org sunt stocate ca fişiere în format XML, fiind astfel uşor editabile 
folosind orice editor de texte. Pe de altă parte, este uşor pentru dumneavoastră să vă jucaţi cu 
ele şi să le stricaţi. Deşi editarea acestor fişiere din alte editoare decât IDE din OOo este o 
greşeală, m-am întâlnit cu o situaţie în care a fost necesară deoarece din cauza unei erori de 
sintaxă OOo nu putea să încarce un modul.
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PONT Editarea manuală a fişierelor OOo este pentru utilizatorii avansaţi. Dacă sunteţi 
începător vă rugăm să treceţi peste această secţiune.

Bibliotecile la nivel de aplica ieţ
Fiecare astfel de bibliotecă este stocată într-un singur director, iar fiecare modul şi dialog este 
conţinut într-un singur fişier. Dialogul Opţiuni (Unelte > Opţiuni > OpenOffice.org > Căi, 
Tools > Options > OpenOffice.org > Paths) cuprinde o intrare ce indică localizarea 
bibliotecilor. Bibliotecile globale furnizate o dată cu OOo sunt stocate într-un director comun 
la locul de instalare al OOo. Exemple:

C:\Program Files\OpenOffice.1.1.1\share\basic  'Instalare pe Windows

/usr/local/OpenOffice.org1.1.1/share/basic     'Instalare pe Linux

Bibliotecile proprii dumneavoastră sunt stocate în alte directoare. Pe calculatorul meu cu 
Windows am o instalare monopost (pentru un singur utilizator) iar pe calculatorul meu cu 
Linux  am o instalare de reţea pentru mai mulţi utilizatori. Opţiunile pe care le exprimaţi în 
timpul instalării OOo afectează localizarea bibliotecilor personale. Iată două exemple:

C:\Program Files\OpenOffice.1.1.1\user\basic  'Fi iereleş  
utilizatorului pe Windows

/home/andy/OpenOffice.org1.1.1/user/basic     'Fi iereleş  
utilizatorului pe Linux

În directorul comun găsim câte un fişier pentru fiecare bibliotecă la nivel de aplicaţie care este 
furnizată o dată cu OOo. Directorul utilizatorului este însă mult mai interesant (vedeţi Tabelul 
1). 

Tabelul 1. Fişierele şi câteva directoare în directorul meu personal.

Intrare Descriere

dialog.xlc Fişier XML care cuprinde informaţii despre fiecare fişier de dialoguri 
accesibile acestui utilizator în OpenOffice.org.

script.xlc Fişier XML  care cuprinde informaţii despre fiecare bibliotecă 
accesibilă acestui utilizator în OpenOffice.org.

Standard Director ce conţine biblioteca Standard.

Pitonyak Director ce conţine o bibliotecă cu codul creat de mine.

PitonyakDialogs Director ce conţine o bibliotecă cu nişte cod şi un dialog (create tot de 
mine).

Notă Tabelul 1 cuprinde directoarele Pitonyak şi PitonyakDialogs. Biblioteca Pitonyak şi 
biblioteca PitonyakDialogs nu au nimic în comun; numele lor sunt similare pentru ca 
eram în pană de inspiraţie. Să nuvă gândiţi cumva că PitonyakDialogs conţine 
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dialogurile pentru biblioteca Pitonyak.

Fişierele dialog.xlc şi script.xlc conţin o referinţă către toate dialogurile şi bibliotecile care sunt 
cunoscute OOo. Bibliotecile afişate în diverse meniuri—ca de exemplu în dialogul Macro şi în 
dialogul Administrare macro-uri (Macro Organizer) (vedeţi Imaginea 16)—sunt obţinute din 
fişierele dialog.xlc şi script.xlc. Dacă aceste două fişiere sunt suprascrise OOo nu va mai şti de 
bibliotecile dumneavoastră chiar dacă ele vor exista în continuare.

Imaginea 16. Dialogul Macro şi dialogul Administrare macro-uri (Macro Organizer) unde sunt 
afişate bibliotecile şi modulele disponibile.

Dialogul Administrare macro-uri (Macro Organizer) arată că biblioteca PitonyakDialogs 
conţine un dialog; selectaţi categoria Module(s) pentru a vedea modulele. Tabelul 2 conţine 
lista fişierelor din directorul PitonyakDialogs. Observaţi că fiecărui modul şi dialog dintr-o 
bibliotecă îi corespunde un fişier.

Tabelul 2. Fişierele din directorul bibliotecii PitonyakDialogs.

Fişier Descriere

dialog.xlb Indică dialogurile conţinute în aceasta bibliotecă.

script.xlb Indică modulele conţinute în aceasta bibliotecă.

Module1.xba Cod BASIC în modulul denumit Module1.

SimpleObjectBrowserCode.xba Cod BASIC în modulul denumit SimpleObjectBrowserCode.

SimpleObjectBrowser.xdl Un dialog în modulul denumit SimpleObjectBrowser.

Fişierele dialog.xlc şi script.xlc din Tabelul 1 indică fişierele dialog.xlb şi script.xlb din 
Tabelul 2. În general, nici unul dintre aceste fişiere nu este permis să fie modificat de mână, 
această posibilitate fiind indicat să o exercitaţi doar dacă apar erori.
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Bibliotecile la nivel de document
Un document OpenOffice.org, salvat pe discul calculatorului, este stocat în formatul ZIP 
standard. Orice program care poate manipula arhive ZIP poate fi folosit pentru a inspecta un 
document OOo—totuşi, s-ar putea sa fie nevoie să schimbati extensia documentului în ZIP 
pentru a putea face aceasta.

După ce dezarhivaţi documentul OOo veţi găsi fişierele în care se găseşte conţinutul propriu-
zis, stilurile şi setările. Există de asemenea şi trei directoare. Directorul META-INF conţine 
referinţe către toate celelalte fişiere, imagini incluse, biblioteci de cod şi dialoguri. Directorul 
Dialogs conţine toate dialogurile incluse, iar directorul Basic conţine toate bibliotecile incluse. 
Observaţi că bibliotecile de la nivelul aplicaţiei sunt stocate puţin diferit decât cele incluse într-
un document.

Cu titlu de experiment, am luat un document care conţinea numeroase controale care apelau o 
anumită bibliotecă. L-am dezarhivat şi apoi am folosit un program de căutare de text pentru a 
găsi toate apelurile către o bibliotecă denumită CH03. Am schimbat apoi toate apariţiile din 
text ale “CH03” în “CH04”, am arhivat înapoi fişierele într-un document OOo, iar OOo a 
încărcat şi a putut utiliza fişierul. Cu alte cuvinte am schimgat cu succes numele unei biblioteci 
incluse în document şi apelurile şi referinţele către ea prin editarea definiţiilor XML. De 
asemenea, dacă doriţi să înlocuiţi rapid toate apariţiile unei imagini, puteţi să dezarhivaţi 
documentul OOo, să suprascrieţi imaginea respectivă iar apoi să îl rearhivaţi.

PONT Scopul acestei secţiuni este acela că, în situaţii de urgenţă sau necesitate, puteţi edita 
manual un document datorită codării XML şi să corectaţi erorile. Totuşi aceasta NU 
este recomandat ca mod de editare al documentelor OOo.

Utilizarea Administrare macro-uri (Macro Organizer)
Administrare macro-uri (Macro Organizer) (Unelte > Macro-uri > Administrare macro-uri > 
OpenOffice.org Basic > Administrare, Tools > Macros > Organize Macros > 
OpenOffice.org Basic > Organizer) este suficient pentru a satisface majoritatea nevoilor 
utilizatorilor cu privire la administrarea modulelor şi a bibliotecilor. Categoria Module(s) din 
dialogul Administrare macro-uri (vedeţi Imaginea 16) vă oferă posibilitatea de a crea şi de a 
şterge module. Dialogul Administrare macro-uri are şi o categorie Biblioteci (Libraries) (vedeţi 
Imaginea 17) de unde se pot crea şi sterge biblioteci. Categoria Biblioteci conţine în partea de 
sus o listă derulantă de unde se poate selecta containerul de biblioteci. Cu alte cuvinte, puteţi 
selecta unul dintre documentele deschise sau bibliotecile de la nivelul aplicaţiei.
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Imaginea 17. Folosiţi Administrare macro-uri (Macro Organizer) pentru a crea, 
adăuga şi a sterge bibliotecile.

Notă Numele unui document este şi numele fişierului care îl conţine, cu excepţia când aţi 
introdus un titlu pentru document din dialogul Caracteristici (Properties) (Fişier > 
Caracteristici > Descriere, File > Properties > Description). Dacă aţi stabilit un 
titlu (Title) va fi folosit ca numele documentului în bara de titlu a ferestrei 
documentului, în dialogul Macro şi în dialogul Administrare macro-uri (Macro 
Organizer).

Redenumirea modulelor şi a bibliotecilor

Puteţi schimba denumirea unui modul sau a unei biblioteci din dialogul Administrare macro-
uri (Macro Organizer). Numele modulelor sunt schimbate din categoria Module(s) iar numele 
bibliotecilor din categoria Biblioteci (Libraries). Când redenumiţi o bibliotecă sau un modul nu 
se va schimba însă nici o referinţă dintre cele existente către macro-urile conţinute în respectva 
bibliotecă sau modul. E ca şi cum aş scrie numărul dumneavoastră de telefon în agenda mea. 
Dacă îl schimbaţi, aceasta nu înseamnă ca se va schimba şi în agenda mea. Aşa că, cine 
apelează un macro?

• Când într-un document sau într-un dialog sunt incluse controale, acestea de obicei 
folosesc macro-uri pentru a efectua acţiunile.

• Macro-urile apelează dialogurile care sunt conţinute în biblioteci.

• Macro-urile pot fi apelate de programe separate faţă de OpenOffice.org.

Aten ieţ Când redenumiţi un modul sau o bibliotecă, referinţele către macro-urile ce le conţin 
nu sunt actualizate.
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Aceasta nu înseamnă ca redenumirea bibliotecilor sau modulelor este contraindicată; trebuie 
doar să ţineţi cont că referinţele nu vor fi actualizate. Dacă nu aţi creat nici un fel de referinţă 
catre codul scris de dumneavoastră sunteti liberi să le redenumiţi după cum doriţi, Puteţi 
redenumi bibliotecile şi modulele folosind Administrare macro-uri (Macro Organizer); 
procedura este aceeaşi pentru ambele tipuri:

1) Găsiţi biblioteca sau modulul în categoria corespunzătoare din Administrare macro-uri 
(Macro Organizer) (vedeţi Imaginea 16 şi Imaginea 17).

2) Selectaţi biblioteca sau modulul.

3) Aşteptaţi un moment şi daţi clic pe bibliotecă sau modul. Ar trebui să apară un cursor 
pentru a edita numele. Mi s-a întâmplat să trebuiască să dau mai multe clic-uri până 
când programul să ţină cont de dorinţa mea. Să nu dati însă dublu clic, deoarece aceasta 
ca duce la deschiderea bibliotecii sau modulului pentru editare.

4) Tastaţi noul nume şi apăsaţi tasta Enter.

Am avut un document foarte mare şi care conţinea numeroase butoane. Butoanele apelau 
macrouri dintr-o bibliotecă, al cărei nume a trebuit să îl schimb. Din păcate, după ce am 
redenumit-o, butoanele încercau să apeleze cu referinţă veche, către numele original, care nu 
mai exista. Într-un acces de îndrăzneală, am dezarhivat documentul OOo cu un utilitar ZIP şi 
am folosit un editor text pentru a înlocui în fiecare fişier numele vechi cu cel nou. După ce am 
terminat şi am arhivat la loc, am obţinut un document în care erau actualizate toate referinţele.

Aten ieţ Păstraţi întotdeauna o copie de fişierului original când editaţi manual documentele 
OOo, deoarece editarea manuală este predispusă greşelilor şi se poate ca OOo să nu 
mai poată încărca sau folosi documentul astfel modificat.

Ad ugarea biblioteciloră

Butonul Adăugare (Append) (vedeţi Imaginea 17) din dialogul Administrare macro-uri 
(Macro Organizer) deschide dialogul Adăugare biblioteci (Append Libraries), care este de fapt 
un dialog pentru selectarea fişierelor, şi anume a acelor fişiere care conţin bibliotecile pe care 
doriţi să le adăugaţi. Pentru a adăuga o bibliotecă dintr-un document începeţi prin a selecta 
documentul. Butonul Deschide (Open) din dialogul Adăugare biblioteci deschide un alt dialog 
intitulat Adăugare biblioteci, de unde alegeti biblioteca dorită (vedeti Imaginea 18). Folosiţi 
dialogul de selectare a bibliotecii pentru a vizualiza bibliotecile conţinute în documentul 
selectat şi pentru a selecta bibliotecile pe care doriţi să le adăugaţi.
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Imaginea 18. Folosiţi dialogul Adăugare biblioteci (Append Libraries) pentru a 
selecta bibliotecile dorite.

Dialogul de selectare a bibliotecilor din Imaginea 18 vă permite să adăugati orice biblioteci 
doriţi. Dacă deja există o bibliotecă cu acel nume aceasta nu va fi suprascrisă, cu excepţia când 
bifaţi căsuţa "Suprascrie bibliotecile existente" (“Replace existing libraries”). Căsuţa 
"Inserează o referinţă" (“Insert as reference”) devine disponibilă numai atunci când adăugati 
biblioteci care nu sunt conţinute într-un document. Apăsaţi OK pentru a adăuga bibliotecile 
selectate.

PONT Nu este posibil să suprascrieţi biblioteca Standard. Nu este recomandabil să folosiţi 
această bibliotecă deoarece nu o puteţi adăuga unui alt document sau aplicaţiei.

Bibliotecile care nu sunt conţinute în documente sunt stocate în dorectoare individuale. Pentru 
a adăuga o astfel de bibliotecă trebuie să deschideţi dialogul de selectare de fişiere Adăugare 
biblioteci (Append Libraries) (vedeţi Imaginea 19) şi să selectaţi directorul care conţine 
fisierele bibliotecii respective. Nu contează unde sunt acestea, pot fi pe discul fix ca şi pe 
dischetă sau în directoarele vechii instalări a versiunii OOo precedente. Când instalez o noua 
versiune de OpenOffice.org obişnuiesc să adaug bibliotecile din vechea instalare.

Când adăugaţi o bibliotecă ce nu este conţinută într-un document sunt listate, în directorul 
corespunzător, două fişiere: dialog.xlb şi script.xlb (vedeţi Tabelul 2 şi Imaginea 19). Ambele 
fişierele sunt necesare şi sunt adăugate ambele indiferent pe care dintre ele îl selectaţi. Adica 
puteti selecta fie dialog.xlb fie script.xlb; ambele vor fi adăugate.
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Imaginea 19. Nu contează care fişier selectaţi, deoarece vor fi adăugate ambele.

PONT Când instalez o noua versiune de OpenOffice.org obişnuiesc să adaug bibliotecile din 
vechea instalare. De asemenea, instalez şi pe celelalte calculatoare pe care lucrez 
bibliotecile pe care le creez şi folosesc.

Capitoul 16, “Library Management”, din OpenOffice.org Macros Explained conţine informaţii 
şi exemple de manipulare şi accesare a bibliotecilor folosind limbajul OOo Basic. 

Concluzie

Macro-urile sunt stocate în module, modulele în biblioteci, iar bibliotecile în containerele de 
biblioteci. Aplicaţia OOo este un astfel de container, ca de altfel orice document OOo. IDE-ul 
este folosit pentru a crea macro-uri şi dialoguri şi pentru a le depana.

Tocmai aţi terminat unul dintre cei mai dificili paşi în scrierea macro-urilor pentru 
OpenOffice.org: scrierea primului dumneavoastră macro! Simţiţi-vă gata de a explora, 
încercaţi şi alte macro-uri şi creaţi câteva şi dumneavoastră.
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